
Q .1Q .1 भा र तभा र त   म
म
   व� जी वव� जी व   संर �णसंर �ण   अ�ध�नयमअ�ध�नयम   िक सिक स   वष�वष �   ला गूला गू   िक यािक या   ग याग या   थाथा ??

A nsA ns 1. 1972

2. 1948

3. 1966

4. 1953

Q .2Q .2 द .लत/द .लत/   केके   अ�धका र/अ�धका र/   केके   .लए.लए   लड़ नेलड़ ने   केके   .लए.लए   बी .आ र .बी .आ र .   अंबेड क रअंबेड क र   नेने   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   संग ठनसंग ठन   क:क:
;ा प ना;ा प ना   क:क:   थीथी ??

A nsA ns 1. बौ> समाज

2. अनुसू@चत जा�त महासंघ

3. DE समाज

4. आय� समाज

Q .3Q .3 झी ल/झी ल/   केके   बा रेबा रे   म
म
   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सेसे   क थनक थन   सहीसही   हHहH ??

1 .  1 .  झी लझी ल   ता जीता जी ,  ,  खा रJखा रJ   याया   लवणी यलवणी य  (fres h,  brac k is h or  s alt is h)   (fres h,  brac k is h or  s alt is h)  होहो   सक तीसक ती   हैहै ।।
2 .  2 .  भा र तभा र त   म
म
   झी ल
झी ल
   के वलके वल   �न6�न6 -- ऊंचा ईऊंचा ई   वा लेवा ले   �े^/�े^/   म
म
   पा ईपा ई   जा तीजा ती   हHहH ।।
3.  3.  वुलरवुलर   झी लझी ल ,  ,  क _ी रक _ी र   घा टीघा टी   क:क:   सबसेसबसे   बड़ीबड़ी   झी लझी ल   हैहै ।।

A nsA ns 1. केवल 2 और 3

2. केवल 1

3. केवल 2

4. केवल 1 और 3

Test Date 25/06/2025
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Subject Correspondence Clerk and Store Assistant

Section : General Knowledge

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .4Q .4 2 0 24 -2 0 2 5 2 0 24 -2 0 2 5 केके   .लए.लए   यूथयूथ   कोको :: लैबलैब   नेशनलनेशनल   इनो वेशनइनो वेशन   चैल
जचैल
ज  ( Youth C o : L ab National  Innovat ion ( Youth C o : L ab National  Innovat ion
C hal lenge)  C hal lenge)  केके  7 7 व
व
   संnर णसंnर ण   काका   अना वर णअना वर ण   िक सनेिक सने   िक यािक या ??

A nsA ns 1. �वo मं^ालय और .सटी फाउंडेशन

2. �वrान एवं sौtोuगक: मं^ालय

3. अटल इनोवेशन �मशन (AIM), नी�त आयोग और UNDP

4. .श�ा मं^ालय और UNDP

Q . 5Q . 5 '' भू�मभू�म   उ प यो गउ प यो ग   स{ |}क:स{ |}क:   प रप र   एकएक   नज़रनज़र :  2 0 2 2 -2 3 '  :  2 0 2 2 -2 3 '  �र पो ट��र पो ट�   केके   अनुसा रअनुसा र ,  ,  शु>शु>   .स ं@चत.स ं@चत   �े^�े^   म
म
   शु>शु>   बो एबो ए   ग एग ए
�े^�े^   काका   �ह�ा�ह�ा   िक सिक स   रा �रा �   केके   .लए.लए   अ�धक त मअ�धक त म   हैहै ??

A nsA ns 1. पंजाब

2. �हमाचल sदेश

3. केरल

4. राजस्थान

Q .6Q .6 भा र ती यभा र ती य   सं�वधा नसं�वधा न   केके   अनु�ेदअनु�ेद  1 24 ( 2 )   1 24 ( 2 )  केके   अनुसा रअनुसा र ,  ,  सव� �सव� �   �ा या लय�ा या लय   केके   �ा या धी श/�ा या धी श/   क:क:   �नयुu��नयुu�   केके   .लए.लए
कौ नकौ न   उ त्उ त्त र दा यीत र दा यी   हैहै ??

A nsA ns 1. भारत के कानून मं^ी

2. भारत के मु} �ायाधीश

3. भारत के रा�� प�त

4. भारत के sधान मं^ी

Q .7Q .7 धनधन   याया   �वoी य�वoी य   �वधेयक�वधेयक   केके   अ�त �र �अ�त �र �   को ईको ई   भीभी   �वधेयक�वधेयक   संसदसंसद   केके   िक सीिक सी   भीभी   सद नसद न   म
म
   s �ुतs �ुत   िक यािक या   जाजा
सक तासक ता   हैहै   औ रऔ र   रा �� प �तरा �� प �त   क:क:   �ी कृ �त�ी कृ �त   केके   .लए.लए   भेजेभेजे   जा नेजा ने   सेसे   प ूव�प ूव�   उ सेउ से   दो न/दो न/   सद न/सद न/   म
म
   पा �र तपा �र त   हो नाहो ना   आ व�कआ व�क
हैहै । । को ईको ई   �वधेयक�वधेयक   याया   तोतो  _________  _________ �ा रा�ा रा   याया   िक सीिक सी   ग ैरगैर -- सर का रJसर का रJ   सद �सद �   �ा रा�ा रा   s �ुतs �ुत   िक यािक या   जाजा   सक तासक ता   हैहै ।।

A nsA ns 1. मं^ी

2. लोकसभा उपा��

3. मु} �ायाधीश

4. भारत के महा�ायवादी
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Q .8Q .8 �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   भा र ती यभा र ती य   रा �रा � , 2 0 24  ,  2 0 24  ;ा नी य;ा नी य   शा सनशा सन   s द श�नs द श�न   सूचक{ कसूचक{ क  ( 2 0 24  L oc al ( 2 0 24  L oc al
G overnance Performance Index)  G overnance Performance Index)  म
म
   शी ष �शी ष �   प रप र   र हार हा ,  ,  जोजो   �वक
 �ी कृ त�वक
 �ी कृ त   �वका स�वका स   औ रऔ र   शा सनशा सन   द �ताद �ता   म
म

एकएक   मह� पूण�मह� पूण�   उ प ल��उ प ल��   हैहै ??

A nsA ns 1. महारा��

2 . केरल

3. कन�टक

4. त�मलनाडु

Q .9Q .9 .सतंबर.सतंबर  2 0 24   2 0 24  म
म
 ,  ,  �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   दे शदे श   आ �धका �र कआ �धका �र क   तौ रतौ र   प रप र   संयु�संयु�   रा �रा �   अमे�र काअमे�र का   केके   नेत ृ�नेत ृ�
वा लेवा ले   समूहसमूह ,  ,  �मनर ��मनर �   .स�ो �र टी.स�ो �र टी   फा इन
सफा इन
स   नेट वक�नेट वक�  ( M inerals  S ec ur ity  Finance Network)   ( M inerals  S ec ur ity  Finance Network)  काका
�ह�ा�ह�ा   बनबन   ग याग या   हैहै ??

A nsA ns 1. चीन

2. भारत

3. ¡ेन

4. ¢ीस

Q .1 0Q .1 0 T2 0  T2 0  �व¤�व¤   क पक प  2 0 24 ,  ________  2 0 24 ,  ________ म
म
   आ यो .जतआ यो .जत   िक यािक या   ग याग या   थाथा ।।

A nsA ns 1. इं¥Hड और �ूजीलHड

2. USA और वे¦ इंडीज

3. भारत और §ीलंका

4. पािक�ान और ब{¥ादेश

Q .1 1Q .1 1 झ¨ सीझ¨ सी   क:क:   रा नीरा नी   क:क:   मृ©ुमृ©ु   अं¢ ेज/अं¢ ेज/   केके   सा थसा थ   यु>यु>   म
म
   िक सिक स   वष�वष �   हुईहुई   थीथी ??

A nsA ns 1. 1858

2. 1867

3. 1859

4. 1862

Q .1 2Q .1 2 ‘‘ दद   �मरै क ल�मरै क ल   मेक स�मेक स�  :   :  इं िड यनइंिड यन   ि« के ट्सि« के ट्स   ¢ेटे ¦¢ेटे ¦   ए िप कएिप क ’ ’ प ु�कपु�क   केके   लेख कलेख क   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न   हHहH ??

A nsA ns 1. बो�रया मजूमदार और न.लन मेहता

2. भारत सुंदरेसन और गौरव जोशी

3. पॉल अ®ण

4. रोनोजॉय सेन
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Q .1 3Q .1 3 मा च�मा च�  2 0 24   2 0 24  म
म
 ,  ,  अनु@चतअनु@चत   कं ट
 टकं ट
 ट   �द खा ने�द खा ने   वा लीवा ली   ¦� ी �म ंग¦� ी �म ंग   सेवा ओंसेवा ओं   प रप र   एकएक   बड़ीबड़ी   का र� वा ईका र� वा ई   केके   त हतत हत ,  ,  भा र तभा र त
सर का रसर का र   नेने   बा रबा र -- बा रबा र   चेता वनीचेता वनी   केके   बा वजूदबा वजूद  ' ' अ°ी लअ°ी ल ,  ,  अभ�अभ�   औ रऔ र   यह{यह{   त कत क   िकिक   पॉ न� ¢ा िफकपॉ न� ¢ा िफक '  '  कं ट
 टकं ट
 ट   क:क:
हो �¦ंगहो �¦ंग   केके   .लए.लए  ________ ' ________ ' ओ वरओ वर -- दद -- टॉ पटॉ प '  (O TT)  '  (O TT)  ²ेट फा म³²ेट फा म³   प रप र   s �त बंधs �त बंध   लगालगा   �द या�द या ।।

A nsA ns 1. 10

2. 18

3. 22

4. 12

Q .1 4Q .1 4 ज´ूज´ू   औ रऔ र   क _ी रक _ी र   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   ख �नजख �नज   काका   एक मा ^एक मा ^   उ µा द कउ µा द क   हैहै ??

A nsA ns 1. बाक्साइट

2. चूना प¶र

3. नीलम

4. त{बा

Q .1 5Q .1 5 प लया ग सला ईप लया ग सला ई   मुदुकु दुमीमुदुकु दुमी   प े®वलुडीप े®वलुडी  ( Paly agas ala i  M udukudumi Peruvaludi)   ( Paly agas ala i  M udukudumi Peruvaludi)  �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे
िक सिक स   रा जवंशरा जवंश   काका   शा सकशा सक   थाथा ??

A nsA ns 1. प{·

2. रा�� कुट

3. सातवाहन

4. प¸व

Q .1 6Q .1 6 भा र ती यभा र ती य   सं�वधा नसं�वधा न   काका   कौ नकौ न -- सासा   भा गभा ग ,  ,  चुना व/चुना व/   सेसे   संबं�धतसंबं�धत   हैहै ??

A nsA ns 1. भाग 15

2. भाग 17

3. भाग 16

4. भाग 18

Q .1 7Q .1 7 भा र तभा र त   म
म
   बा ¹ दबा ¹ द   औ रऔ र   तो प खा नेतो प खा ने   काका   s यो गs यो ग   सव�s थमसव�s थम   िक सिक स   मुग लमुग ल   सºा टसºा ट   नेने   िक यािक या   थाथा ??

A nsA ns 1. बाबर

2. अकबर

3. हुमायूं

4. जह{गीर
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Q .1 8Q .1 8 भा र तभा र त   क:क:  2 0 1 1   2 0 1 1  क:क:   जनग णनाजनग णना   केके   अनुसा रअनुसा र ,  ,  भा र तभा र त   म
म
   िक सिक स   धम�धम�   क:क:   शहरJशहरJ   जनसं}ाजनसं}ा   सबसेसबसे   अ�धकअ�धक   हैहै ??

A nsA ns 1. जैन धम�

2. ईसाई धम�

3. .सख धम�

4. इ»ाम धम�

Q .1 9Q .1 9 मु¼»ममु¼»म   ली गली ग   क:क:   ;ा प ना;ा प ना   केके   समयसमय   इसकाइसका   sा थ�मकsा थ�मक   उ ½े�उ ½े�   �ा�ा   थाथा ??

A nsA ns 1. मुसलमान/ के .लए एक अलग रा� बनाना

2. भारतीय मुसलमान/ के अ�धकार/ क: र�ा करना

3. �हदंू-मु¼»म एकता को बढ़ावा देना

4. �Dिटश शासन से �तं^ता क: म{ग करना

Q .2 0Q .2 0 �द ए�द ए   ग एग ए   यु¿/यु¿/   म
म
   सेसे   सुमे.लतसुमे.लत   यु¿/यु¿/   काका   चयनचयन   क: .जएक: .जए ।।

1 .  1 .  लो क सभालो क सभा   क:क:   s थमs थम   म�हलाम�हला   अ��अ��  :   :  मी रामी रा   कु मा रकु मा र
2 .  2 .  भा र तभा र त   क:क:   s थमs थम   म�हलाम�हला   रा �� प �तरा �� प �त  :   :  s �त भाs �त भा   पा िट लपा िट ल
3.  3.  भा र तभा र त   क:क:   s थमs थम   म�हलाम�हला   s धा नमं^ीs धा नमं^ी  :   :  इं �द राइं �द रा   ग{ धीग{ धी

A nsA ns 1. 1, 2 और 3

2. केवल 1 और 2

3. केवल 3

4. केवल 2 और 3

Q .2 1Q .2 1 य�दय�द   शÀशÀ  ‘S TUM PE D’  ‘S TUM PE D’ केके   s ©ेकs ©ेक   अ�रअ�र   कोको   अं¢ ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   म
म
   उ सकेउ सके   ठÂ कठÂ क   बा दबा द   वा लेवा ले   अ�रअ�र   सेसे
बद लबद ल   �द या�द या   जा एजा ए ,  ,  तोतो   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   अ�रअ�र   इसइस   s का रs का र   बनेबने   अ�र/अ�र/   केके   नएनए   समूहसमूह   म
म
   दा Ãदा Ã   ओ रओ र   सेसे
ती सराती सरा   हो गाहो गा ??

A nsA ns 1. F

2. N

3. U

4. Q

Section : Logical Reasoning
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Q .2 2Q .2 2 य�दय�द   सं}ासं}ा  3 4 5781 6  3 4 5781 6 केके   s ©ेकs ©ेक   �वष म�वष म   अंकअंक   म
म
  2   2  जो ड़ाजो ड़ा   जा एजा ए   त थात था   s ©ेकs ©ेक   समसम   अंकअंक   म
म
   सेसे  3   3  घ टा याघ टा या   जा एजा ए ,,
तोतो   इसइस   s का रs का र   बनीबनी   नईनई   सं}ासं}ा   म
म
   िक त नेिक त ने   अंकअंक   एकएक   सेसे   अ�धकअ�धक   बा रबा र   आ एंगेआ एंगे ??

A nsA ns 1. दो

2. तीन

3. एक भी नहÄ

4. एक

Q .2 3Q .2 3 शÀशÀ  TE C HNIC A L   TE C HNIC A L  म
म
   s ©ेकs ©ेक   �र�र   कोको   अं¢ ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   म
म
   उ सकेउ सके   ठÂ कठÂ क   बा दबा द   वा लेवा ले   अ�रअ�र   सेसे   बद लबद ल
�द या�द या   जा ताजा ता   हैहै   औ रऔ र   s ©ेकs ©ेक   ÆंजनÆंजन   कोको   अं¢ ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   म
म
   उ सकेउ सके   ठÂ कठÂ क   प हलेप हले   वा लेवा ले   अ�रअ�र   सेसे   बद लबद ल   �द या�द या
जा ताजा ता   हैहै । । �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   अ�रअ�र   नएनए   बनेबने   अ�र/अ�र/   केके   समूहसमूह   म
म
   दा एंदा एं   सेसे   चौ थाचौ था   हो गाहो गा ??

A nsA ns 1. J

2. F

3. B

4. K

Q .24Q .24 शÀशÀ  FA BRIC ATIO N  FA BRIC ATIO N म
म
   s ©ेकs ©ेक   �र�र   कोको   अं¢ ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   म
म
   उ ससेउ ससे   प हलेप हले   आ नेआ ने   वा लेवा ले   दूस रेदूस रे   अ�रअ�र   सेसे
बद लबद ल   �द या�द या   जा ताजा ता   हैहै   औ रऔ र   s ©ेकs ©ेक   ÆंजनÆंजन   कोको   अं¢ ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   म
म
   उ सकेउ सके   ठÂ कठÂ क   बा दबा द   वा लेवा ले   अ�रअ�र   सेसे   बद लबद ल
�द या�द या   जा ताजा ता   हैहै । । �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   अ�रअ�र   इसइस   s का रs का र   बनेबने   अ�रअ�र -- समूहसमूह   म
म
   ठÂ कठÂ क   ती नती न   बा रबा र   आ एगाआ एगा ??

A nsA ns 1. G

2. M

3. Y

4. D

Q .2 5Q .2 5 य�दय�द   सं}ासं}ा  973 564 2   973 564 2  म
म
   s ©ेकs ©ेक   समसम   अंकअंक   म
म
  2   2  जो ड़ाजो ड़ा   जा एजा ए   औ रऔ र   s ©ेकs ©ेक   �वष म�वष म   अंकअंक   म
म
   सेसे  1   1  घ टा याघ टा या   जा एजा ए ,,
तोतो   इसइस   s का रs का र   बनीबनी   नईनई   सं}ासं}ा   म
म
   बा एंबा एं   सेसे   ती स रेती स रे   औ रऔ र   दा एंदा एं   सेसे   ती स रेती स रे   अंक/अंक/   काका   यो गयो ग   �ा�ा   हो गाहो गा ??

A nsA ns 1. 14

2. 10

3. 8

4. 12

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .2 6Q .2 6 एकएक   का ग ज़का ग ज़   कोको   मो ड़ क रमो ड़ क र   का टाका टा   जा ताजा ता   हैहै   जैसाजैसा   िकिक   नी चेनी चे   द श� याद श� या   ग याग या   हैहै । । इसइस   का ग ज़का ग ज़   कोको   खो लनेखो लने   प रप र   यहयह
कै साकै सा   �द खा ई�द खा ई   दे गादे गा ??

A nsA ns 1. 

2. 

3. 

4. 

Q .2 7Q .2 7 एकएक   क �ाक �ा   केके   सभीसभी  3 5  3 5 �वtा थË�वtा थË   उ o रउ o र   क:क:   ओ रओ र   अ�भमुखअ�भमुख   हो क रहो क र   एकएक   सी धीसी धी   रेखारेखा   म
म
   ख ड़ेख ड़े   हHहH । । सो हमसो हम   दा एंदा एं   छो रछो र
सेसे  1 5 1 5 व
व
   ;ा न;ा न   प रप र   हैहै ,  ,  जबिकजबिक   �र या�र या   बा एंबा एं   छो रछो र   सेसे  2 0 2 0 व
व
   ;ा न;ा न   प रप र   हैहै । । �र या�र या   औ रऔ र   सो हमसो हम   केके   बी चबी च   िक त नेिक त ने   Æ u�Æ u�
ख ड़ेख ड़े   हHहH ??

A nsA ns 1. 1

2. 0

3. 2

4. 3
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Q .2 8Q .2 8 नी चेनी चे   सं}ा ओंसं}ा ओं   केके   दोदो   समु�यसमु�य   �द ए�द ए   ग एग ए   हHहH । । सं}ा ओंसं}ा ओं   केके   s ©ेकs ©ेक   समु�यसमु�य   म
म
 ,  ,  प हलीप हली   सं}ासं}ा   प रप र   �न.Íत�न.Íत
ग Îणती यग Îणती य   संि« यासंि« या (( ओंओं )  )  केके   प �र णा म�¹ पप �र णा म�¹ प   दूसरJदूसरJ   सं}ासं}ा   sा Ïsा Ï   हो तीहो ती   हैहै । । इसीइसी   s का रs का र ,  ,  दूसरJदूसरJ   सं}ासं}ा   प रप र
�न.Íत�न.Íत   ग Îणती यग Îणती य   संि« यासंि« या (( ओंओं )  )  केके   प �र णा म�¹ पप �र णा म�¹ प   ती सरJती सरJ   सं}ासं}ा   sा Ïsा Ï   हो तीहो ती   हैहै   औ रऔ र   यहयह   « म« म   इसीइसी
s का र आ गेs का र आ गे   भीभी   जा रJजा रJ   र हतार हता   हैहै । । �द ए�द ए   ग एग ए   �वक Ð/�वक Ð/   म
म
   सेसे   कौ नकौ न -- सासा   �वक Ð�वक Ð   s Ñs Ñ   केके   समु�य/समु�य/   म
म
   अप ना ईअप ना ई   ग ईग ई
संि« या ओंसंि« या ओं   केके   समा नसमा न   समु�यसमु�य   काका   अनुसर णअनुसर ण   क र ताक र ता   हैहै ??

(( नो टनो ट :  :  ग Îणती यग Îणती य   संि« या एंसंि« या एं ,  ,  सं}ा ओंसं}ा ओं   कोको   उ नकेउ नके   घ ट कघ ट क   अंक/अंक/   म
म
   तो ड़ेतो ड़े   �बना�बना ,  ,  प ूण�प ूण�   सं}ा ओंसं}ा ओं   प रप र   क:क:   जा नीजा नी
चा �हएचा �हए । । उ दा हर णउ दा हर ण   केके   .लए.लए  1 3   1 3  कोको   ली .जएली .जए  -  1 3   -  1 3  प रप र   ग Îणती यग Îणती य   संि« या एंसंि« या एं   जैसेजैसे   िकिक  1 3   1 3  कोको
जो ड़ नाजो ड़ ना // घ टा नाघ टा ना // गुणागुणा   क र नाक र ना ,  ,  आ �दआ �द   िक यािक या   जाजा   सक तासक ता   हैहै । 1 3  । 1 3  कोको  1   1  औ रऔ र  3   3  म
म
   तो ड़ नातो ड़ ना   औ रऔ र   िफरिफर  1   1  औ रऔ र  3   3  प रप र
ग Îणती यग Îणती य   संि« या एंसंि« या एं   क र नेक र ने   क:क:   अनुम�तअनुम�त   नहÄनहÄ   हैहै ।)।)

1 7- 51 - 1 0 2 - 1 1 7;  1 9- 57- 1 1 4 - 1 2 91 7- 51 - 1 0 2 - 1 1 7;  1 9- 57- 1 1 4 - 1 2 9

A nsA ns 1. 13-39-78-83

2. 11-33-66-76

3. 15-45-90-105

4. 14-42-84-98

Q .2 9Q .2 9 दीदी   ग ईग ई   §ृंख ला§ृंख ला   म
म
   s Ñवा चकs Ñवा चक   @चÔ@चÔ  ( ? )   ( ? )  केके   ;ा न;ा न   प रप र   �ा�ा   आ नाआ ना   चा �हएचा �हए ??

1 5,  1 9 ,  1 4 ,  2 3,  1 3,  2 7,  ?1 5,  1 9 ,  1 4 ,  2 3,  1 3,  2 7,  ?

A nsA ns 1. 17

2. 31

3. 28

4. 12

Q .3 0Q .3 0 अं¢ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   केके   आ धा रआ धा र   प रप र ,  ,  �न6.ल7ख त�न6.ल7ख त   चा रचा र   अ�रअ�र -- समूह/समूह/   म
म
   सेसे   ती नती न   एकएक   �न.Íत�न.Íत   त रJ केत रJ के   सेसे
एक समा नएक समा न   हHहH   औ रऔ र   इसइस   s का रs का र   वेवे   एकएक   ¢ुप¢ुप   बना तेबना ते   हHहH । । कौ नकौ न -- सासा   अ�रअ�र -- समूहसमूह ,  ,  उ सउ स   ¢ुप¢ुप   सेसे   संबं�धतसंबं�धत   नहÄनहÄ   हैहै ??
(( नो टनो ट :  :  असंग तअसंग त   अ�रअ�र -- समूहसमूह   उ सम
उ सम
   Æंजन/Æंजन/ // �र/�र/   क:क:   सं}ासं}ा   याया   उ नक:उ नक:   Õ; �तÕ; �त   प रप र   आ धा �र तआ धा �र त   नहÄनहÄ   हैहै ।)।)

A nsA ns 1. ZWC

2. BYG

3. HEK

4. QNT
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Q .3 1Q .3 1 िक सीिक सी   �न.Íत�न.Íत   कू टकू ट   भा षाभा षा   म
म
 ,,
‘P  + Q ’ ‘P  + Q ’ काका   अथ�अथ�   हैहै   िकिक  ‘P,  Q   ‘P,  Q  क:क:   मा तामा ता   हैहै ’ ,’ ,
‘P  – Q ’ ‘P  – Q ’ काका   अथ�अथ�   हैहै   िकिक  ‘P,  Q   ‘P,  Q  क:क:   बहनबहन   हैहै ’ ,’ ,
‘P  x  Q ’ ‘P  x  Q ’ काका   अथ�अथ�   हैहै   िकिक  ‘P,  Q   ‘P,  Q  क:क:   प Úीप Úी   हैहै ’ ’ औ रऔ र
‘P  ÷  Q ’ ‘P  ÷  Q ’ काका   अथ�अथ�   हैहै   िकिक  ‘P,  Q   ‘P,  Q  काका   िप तािप ता   हैहै ’ ।’।

य �दय�द  ‘T  x  B  ÷  C  + E  – Z ’  ‘T  x  B  ÷  C  + E  – Z ’ हैहै ,  ,  तोतो  T   T  काका  E   E  सेसे   �ा�ा   संबंधसंबंध   हैहै ??

A nsA ns 1. माता क: बहन

2. पु^ी क: पु^ी

3. प�त क: बहन

4. पु^ी

Q .3 2Q .3 2 �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   अ�रअ�र -- समूहसमूह   �ा रा�ा रा ,  # ,  # औ रऔ र  %  % कोको   s �त ;ा िप तs �त ;ा िप त   िक यािक या   जा नाजा ना   चा �हएचा �हए   .जससे.जससे   िकिक  : : : :
केके   बा Ãबा Ã   ओ रओ र   केके   अ�रअ�र -- समूहसमूह   यु¿यु¿   केके   बी चबी च   काका   प ैट न�प ैट न�   औ रऔ र   संबंधसंबंध ,  : :  ,  : :  केके   दा Ãदा Ã   ओ रओ र   केके   अ�रअ�र -- समूहसमूह   यु¿यु¿   केके   बी चबी च
केके   प ैट न�प ैट न�   औ रऔ र   संबंधसंबंध   केके   समा नसमा न   होहो   जा एजा ए ??

# :  HKL  : :  DG H :  %# :  HKL  : :  DG H :  %

A nsA ns 1. # = FIJ, % = FHK

2. # = FII, % = EHI

3. # = FKL, % = FIJ

4. # = FIJ, % = FIJ

Q .3 3Q .3 3 A ,  B,  C ,  D  A ,  B,  C ,  D  औ रऔ र  E   E  उ o रउ o र   �द शा�द शा   क:क:   ओ रओ र   अ�भमुखअ�भमुख   हो क रहो क र   एकएक   प ंu�पंu�   म
म
   बैठेबैठे   हHहH । B  । B  केके   दा Ãदा Ã   ओ रओ र   के वलके वल   दोदो
Æ u�Æ u�   बैठेबैठे   हHहH । C  । C  औ रऔ र  D  D  प ंu�पंu�   केके   दोदो   छो र/छो र/   प रप र   बैठेबैठे   हHहH । E ,  D  । E ,  D  केके   ठÂ कठÂ क   दा Ãदा Ã   ओ रओ र   प ड़ो सप ड़ो स   म
म
   बैठाबैठा   हैहै ।।
B  B  केके   ठÂ कठÂ क   दा Ãदा Ã   ओ रओ र   प ड़ो सप ड़ो स   म
म
   कौ नकौ न   बैठाबैठा   हैहै ??

A nsA ns 1. C

2. E

3. A

4. D
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Q .3 4Q .3 4 �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   अ�रअ�र -- समूहसमूह   �ा रा�ा रा ,  # ,  # औ रऔ र  %  % कोको   s �त ;ा िप तs �त ;ा िप त   िक यािक या   जा नाजा ना   चा �हएचा �हए   .जससे.जससे   िकिक  : : : :
केके   बा Ãबा Ã   ओ रओ र   केके   अ�रअ�र -- समूहसमूह   यु¿यु¿   केके   बी चबी च   काका   प ैट न�प ैट न�   औ रऔ र   संबंधसंबंध ,  : :  ,  : :  केके   दा Ãदा Ã   ओ रओ र   केके   अ�रअ�र -- समूहसमूह   यु¿यु¿   केके   बी चबी च
केके   प ैट न�प ैट न�   औ रऔ र   संबंधसंबंध   केके   समा नसमा न   होहो   जा एजा ए ??

# :  JM U : :  C RM  :  %# :  JM U : :  C RM  :  %

A nsA ns 1. # = HKS, % = ETO

2. # = ILS, % = DTO

3. # = HKT, % = ESN

4. # = HLS, % = ETN

Q .3 5Q .3 5 HY 1 8  HY 1 8  िक सीिक सी   �न.Íत�न.Íत   त रJ केत रJ के   सेसे  JV  4   JV  4  सेसे   संबं�धतसंबं�धत   हैहै । G L  2 9 । G L  2 9 उ सीउ सी   त रJ केत रJ के   सेसे  I I  1 5  I I  1 5 सेसे   संबं�धतसंबं�धत   हैहै । । समा नसमा न
त क�त क�   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  E L  9  ,  E L  9  �द ए�द ए   ग एग ए   �वक Ð/�वक Ð/   म
म
   सेसे   िक ससेिक ससे   संबं�धतसंबं�धत   हैहै ??

A nsA ns 1. GI −5

2. GH −7

3. FI −7

4. FH −5

Q .3 6Q .3 6 दीदी   ग ईग ई   §ृंख ला§ृंख ला   म
म
   s Ñs Ñ -- @चÔ@चÔ  ( ? )   ( ? )  केके   ;ा न;ा न   प रप र   �ा�ा   आ नाआ ना   चा �हएचा �हए ??

2 0  2 0  4 0  4 0  60  60  80  80  1 0 0  1 0 0  ??

A nsA ns 1. 120

2. 115

3. 125

4. 110
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Q .3 7Q .3 7 �न6.ल7ख त�न6.ल7ख त   अ�रअ�र -- §ृंख ला§ृंख ला   काका   संद भ�संद भ�   ली .जएली .जए   औ रऔ र   उ सकेउ सके   बा दबा द   आ नेआ ने   वा लेवा ले   s Ñs Ñ   काका   उ o रउ o र   दी .जएदी .जए । । uग नतीuग नती
के वलके वल   बा एंबा एं   सेसे   दा एंदा एं   क:क:   जा नीजा नी   हैहै ।।
(( बा एंबा एं )  V  )  V  X  X  Y  Y  T  T  R R E  E  S  S  I  I  C  C  B  B  J  J  A  A  N N A  A  Q  Q  F F K K H H Q  Q  U U G  (G  ( दा एंदा एं ))
ऐसेऐसे   िक त नेिक त ने   ÆंजनÆंजन   हHहH   .जनम
.जनम
   सेसे   s ©ेकs ©ेक   केके   ठÂ कठÂ क   प हलेप हले   एकएक   �र�र   हैहै   औ रऔ र   ठÂ कठÂ क   बा दबा द   म
म
   भीभी   एकएक   �र�र   हैहै ??

A nsA ns 1. दो

2. तीन

3. एक भी नहÄ

4. एक

Q .3 8Q .3 8 अं¢ेजीअं¢ ेजी   वण�मा लावण�मा ला   « म« म   केके   आ धा रआ धा र   प रप र ,  ,  �न6.ल7ख त�न6.ल7ख त   चा रचा र   अ�रअ�र -- समूह/समूह/   म
म
   सेसे   ती नती न   एकएक   �न.Íत�न.Íत   त रJ केत रJ के   सेसे
समा नसमा न   हHहH   औ रऔ र   इसइस   s का रs का र   वेवे   एकएक   ¢ुप¢ुप   बना तेबना ते   हHहH । । कौ नकौ न -- सासा   अ�रअ�र -- समूहसमूह   उ सउ स   ¢ुप¢ुप   सेसे   संबं�धतसंबं�धत   नहÄनहÄ   हैहै ?  ?  
(( नो टनो ट :  :  असंग तअसंग त   अ�रअ�र -- समूहसमूह ,  ,  Æंजन/Æंजन/ // �र/�र/   क:क:   सं}ासं}ा   याया   म
म
   उ नक:उ नक:   Õ; �तÕ; �त   प रप र   आ धा �र तआ धा �र त   नहÄनहÄ   हैहै ।)।)

A nsA ns 1. KTC

2. PYH

3. RAW

4. UDM

Q .3 9Q .3 9 य�दय�द   सं}ासं}ा  3 4 653 82 7   3 4 653 82 7  म
म
   s ©ेकs ©ेक   समसम   अंकअंक   म
म
  1   1  जो ड़ाजो ड़ा   जा एजा ए   त थात था   s ©ेकs ©ेक   �वष म�वष म   अंकअंक   म
म
   सेसे  2   2  घ टा याघ टा या   जा एजा ए ,,
तोतो   इसइस   s का रs का र   बनीबनी   नईनई   सं}ासं}ा   म
म
   िक त नेिक त ने   अंकअंक   एकएक   सेसे   अ�धकअ�धक   बा रबा र   आ एंगेआ एंगे ??

A nsA ns 1. एक भी नहÄ

2. एक

3. तीन

4. दो

https://applink.adda247.com/d/XhqWf9lSap
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Q .4 0Q .4 0 3  3  एकएक   �न.Íत�न.Íत   त क�त क�   केके   अनुसा रअनुसा र  1 0   1 0  सेसे   संबं�धतसंबं�धत   हैहै । । उ सीउ सी   त क�त क�   केके   अनुसा रअनुसा र  5,  1 0 8  5,  1 0 8 सेसे   संबं�धतसंबं�धत   हैहै । । उ सीउ सी   त क�त क�
केके   अनुसा रअनुसा र ,  7  ,  7  �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक ससेिक ससे   संबं�धतसंबं�धत   हैहै ??

(( नो टनो ट :  :  सं}ा ओंसं}ा ओं   कोको   उ नकेउ नके   घ ट कघ ट क   अंक/अंक/   म
म
   तो ड़ेतो ड़े   �बना�बना ,  ,  संि« या एंसंि« या एं   प ूण�प ूण�   सं}ा ओंसं}ा ओं   प रप र   क:क:   जा नीजा नी   चा �हएचा �हए ।।
उ दा हर णउ दा हर ण   केके   .लए.लए  1 3   1 3  कोको   ली .जएली .जए -  1 3  -  1 3  प रप र   संि« या एंसंि« या एं   जैसेजैसे   िकिक  1 3   1 3  म
म
   जो ड़ नाजो ड़ ना // घ टा नाघ टा ना // गुणागुणा   क र नाक र ना   आ �दआ �द
िक यािक या   जाजा   सक तासक ता   हैहै । 1 3  । 1 3  कोको  1   1  औ रऔ र  3   3  म
म
   तो ड़ नातो ड़ ना   औ रऔ र   िफरिफर  1   1  औ रऔ र  3   3  प रप र   ग Îणती यग Îणती य   संि« या एंसंि« या एं   क र नेक र ने   क:क:
अनुम�तअनुम�त   नहÄनहÄ   हैहै ।)।)

A nsA ns 1. 326

2. 328

3. 324

4. 322

Q .4 1Q .4 1 S elec t  the mos t appropr iate s y nony m of the given word .S elec t  the mos t appropr iate s y nony m of the given word .

ValeVale

A nsA ns 1. Valley

2. Summit

3. Plateau

4. Pinnacle

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
S he was  t ired __ s he took  res t .S he was  t ired __ s he took  res t .

A nsA ns 1. therefore

2. otherwise

3. yet

4. because

Section : General English and Comprehension
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Q .43Q .43 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given groupS elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group
of words .of  words .

A  pers on who c an us e both hands  with equal  s k i l lA  pers on who c an us e both hands  with equal  s k i l l

A nsA ns 1. Maladroit

2. Clumsy

3. Inept

4. Ambidextrous

Q .4 4Q .4 4 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

He _____ dec ided not to  talk  to  s trangers .He _____ dec ided not to  talk  to  s trangers .

A nsA ns 1. gracefully

2. wisely

3. gloomily

4. merrily

Q .4 5Q .4 5 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.
A  c lean s lateA  c lean s late

A nsA ns 1. A list of things that need to be cleaned up

2. A clever plan that erases all problems instantly

3. A situation where someone makes the same mistake again

4. A fresh start without considering past mistakes or events

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

One 2002 study of more than 800 nuns in the United States found that frequently
participating in cognitively stimulating activities reduced their risk of Alzheimer ’s
disease. A more recent study of older adults in Japan found participation in
meaningful activities could protect against declines in memory function.
Meanwhile, other research has found that people who received an intervention of
cognitively stimulating activities, typically in a social setting, saw improvements in
cognition, mood, communication and social interaction.
Gardening appears to have specific cognitive benefits. For one thing, gardeners
seem to experience gains in the nerve levels of brain-derived neurotrophic factor
(BDNF), a protein that plays an important role in the growth and survival of
neurons. They also receive boosts to their vascular endothelial growth factor
(VEGF), a protein associated with improving cognitive functioning. Gardening
has also been shown to improve attention, lessen stress, reduce falls and lower
reliance on medications.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6

Q .4 6Q .4 6 S elec t  the mos t appropr iate t it le for  the pas s age.S elec t  the mos t appropr iate t it le for  the pas s age.

A nsA ns 1. How to Boost Brain Health

2. How to Reduce Appetite and Weight

3. How to Strengthen Memory and Focus

4. How to Prevent Alzheimer’s

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

One 2002 study of more than 800 nuns in the United States found that frequently
participating in cognitively stimulating activities reduced their risk of Alzheimer ’s
disease. A more recent study of older adults in Japan found participation in
meaningful activities could protect against declines in memory function.
Meanwhile, other research has found that people who received an intervention of
cognitively stimulating activities, typically in a social setting, saw improvements in
cognition, mood, communication and social interaction.
Gardening appears to have specific cognitive benefits. For one thing, gardeners
seem to experience gains in the nerve levels of brain-derived neurotrophic factor
(BDNF), a protein that plays an important role in the growth and survival of
neurons. They also receive boosts to their vascular endothelial growth factor
(VEGF), a protein associated with improving cognitive functioning. Gardening
has also been shown to improve attention, lessen stress, reduce falls and lower
reliance on medications.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47

Q .47Q .47 What benefit is  gardening as s oc iated with,  acc ording to  the pas s age?What benefit is  gardening as s oc iated with,  acc ording to  the pas s age?

A nsA ns 1. Attention improving with gardening

2. Coordination suffering with exercise

3. Social skills weakening outside

4. Memory worsening from plants
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

One 2002 study of more than 800 nuns in the United States found that frequently
participating in cognitively stimulating activities reduced their risk of Alzheimer ’s
disease. A more recent study of older adults in Japan found participation in
meaningful activities could protect against declines in memory function.
Meanwhile, other research has found that people who received an intervention of
cognitively stimulating activities, typically in a social setting, saw improvements in
cognition, mood, communication and social interaction.
Gardening appears to have specific cognitive benefits. For one thing, gardeners
seem to experience gains in the nerve levels of brain-derived neurotrophic factor
(BDNF), a protein that plays an important role in the growth and survival of
neurons. They also receive boosts to their vascular endothelial growth factor
(VEGF), a protein associated with improving cognitive functioning. Gardening
has also been shown to improve attention, lessen stress, reduce falls and lower
reliance on medications.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8

Q .4 8Q .4 8 What is  the tone of the s peaker?What is  the tone of the s peaker?

A nsA ns 1. Optimistic

2. Apologetic

3. Cynical

4. Jovial
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

One 2002 study of more than 800 nuns in the United States found that frequently
participating in cognitively stimulating activities reduced their risk of Alzheimer ’s
disease. A more recent study of older adults in Japan found participation in
meaningful activities could protect against declines in memory function.
Meanwhile, other research has found that people who received an intervention of
cognitively stimulating activities, typically in a social setting, saw improvements in
cognition, mood, communication and social interaction.
Gardening appears to have specific cognitive benefits. For one thing, gardeners
seem to experience gains in the nerve levels of brain-derived neurotrophic factor
(BDNF), a protein that plays an important role in the growth and survival of
neurons. They also receive boosts to their vascular endothelial growth factor
(VEGF), a protein associated with improving cognitive functioning. Gardening
has also been shown to improve attention, lessen stress, reduce falls and lower
reliance on medications.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9

Q .4 9Q .4 9 What d id  the 2 0 0 2  s tudy  c onc lude as  per  the pas s age?What d id  the 2 0 0 2  s tudy  c onc lude as  per  the pas s age?

A nsA ns 1. Gardening increased the BDNF levels.

2. Stimulating activities reduced the risk of Alzheimer’s disease.

3. Japan found memory improvement.

4. Social settings improved communication.
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

One 2002 study of more than 800 nuns in the United States found that frequently
participating in cognitively stimulating activities reduced their risk of Alzheimer ’s
disease. A more recent study of older adults in Japan found participation in
meaningful activities could protect against declines in memory function.
Meanwhile, other research has found that people who received an intervention of
cognitively stimulating activities, typically in a social setting, saw improvements in
cognition, mood, communication and social interaction.
Gardening appears to have specific cognitive benefits. For one thing, gardeners
seem to experience gains in the nerve levels of brain-derived neurotrophic factor
(BDNF), a protein that plays an important role in the growth and survival of
neurons. They also receive boosts to their vascular endothelial growth factor
(VEGF), a protein associated with improving cognitive functioning. Gardening
has also been shown to improve attention, lessen stress, reduce falls and lower
reliance on medications.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50

Q . 50Q . 50 Identify  the mos t appropr iate word given in the pas s age whic h is  an A NTO NYMIdentify  the mos t appropr iate word given in the pas s age whic h is  an A NTO NYM
of ' independence' .of  ' independence' .

A nsA ns 1. intervention

2. reliance

3. participation

4. cognition

Section : General Hindi and Comprehension
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Q . 51Q . 51 '' एकएक   आँखआँख   सेसे   दे ख नादे ख ना '  '  मुहा वरामुहा वरा   काका   सहीसही   अथ�अथ�   हैहै  - -

A nsA ns 1. समान éिê से देखना

2. चालबाजी क: éि� से देखना

3. भेद-भाव क: éि� से देखना।

4. .शकार क: éि� से देखना

Q . 52Q . 52 मुहा वरेमुहा वरे   केके   सहीसही   अथ�अथ�   काका   चयनचयन   क र
क र
 --
‘‘ द¨ तद¨ त   uग ननाuग नना ’’

A nsA ns 1. हार मानना

2. उº बताना

3. बुरे  �दन आना

4. प� करना

Q . 53Q . 53 '' ता म.सकता म.सक '  '  काका   �वलो म�वलो म   शÀशÀ   हो गाहो गा  - -

A nsA ns 1. स©ानë

2. स�

3. स©वंत

4. सा�ìक

Q . 54Q . 54 �न6�न6   म
म
   सेसे  ' ' रा ि^रा ि^ '  '  काका   प य� यवा चीप य� यवा ची   कौ नकौ न -- सासा   नहÄनहÄ   हैहै  ? ?

A nsA ns 1. �णदा

2. ि^यामा

3. त�ड़त

4. शव�रJ

Q . 55Q . 55 �द ए�द ए   ग एग ए   वा �वा �   म
म
   �र ��र �   ;ा न;ा न   केके   .लए.लए   उ प यु�उ प यु�   शÀशÀ   चुन
चुन
 ।।
वहवह   सजासजा  . . . . . . . . . . .   . . . . . . . . . . .  केके   ला यकला यक   हैहै ।।

A nsA ns 1. नाल

2. uगरने

3. पाने

4. होने

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:

�दए गए गt{श के आधार पर �न6{िकत sÑ/ के उoर दी.जए--
संसदीय sजातं^ म
 सदन के दो प� होते हH। एक सoा प� जो सरकार का �नम�ण करता है तथा दूसरा �वप� जो
सoा के संचालन को संतु.लत एवं �नयंि^त करता है। सरकार का काम शासन चलाना होता है और �वप� का काय�
सरकार क: नी�तय/ क: आलोचना एवं वैकÕÐक नी�तय¨ s�ुत करना होता है। �वप� के कारण ही सरकार
मनमानी कर नाग�रक �तं^ता का हनन नहÄ कर पाती। �वप�ी दल आलोचना करने के .लए �न6 साधन/ का sयोग
करते हH-- sÑोoर, अÐकालीन चच�, ;गन s�ाव, �ानाकष�ण s�ाव, �वशेषा�धकार का sÑ, सदन का अवमान,
अ�व¤ास s�ाव, �नंदा s�ाव आ�द। �वप� �ारा समय-समय पर क: गयी आलोचना से जनता को सरकार क:
नी�तय/ व उसके कृ©/ का अनौ@च© अव� मालूम होता रहता है। �वप� के सतक�  रहने का प�रणाम यह होता है िक
शासन जनमत के s�त जाग®क बना रहता है।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56

Q . 56Q . 56 �वप ��वप �   केके   सत क�सत क�   र हनेर हने   काका   एकएक   प �र णा मप �र णा म   यहयह   भीभी   हैहै - -- -

A nsA ns 1. सरकार अपनी नी�तय¨ लागू नहÄ कर पाती

2. शासन जनमत के s�त जाग¹क रहता है

3. शासन जनता के �व®> काय� करता है

4. सरकार सoा नहÄ चला पाती
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C omprehens ion:C omprehens ion:

�दए गए गt{श के आधार पर �न6{िकत sÑ/ के उoर दी.जए--
संसदीय sजातं^ म
 सदन के दो प� होते हH। एक सoा प� जो सरकार का �नम�ण करता है तथा दूसरा �वप� जो
सoा के संचालन को संतु.लत एवं �नयंि^त करता है। सरकार का काम शासन चलाना होता है और �वप� का काय�
सरकार क: नी�तय/ क: आलोचना एवं वैकÕÐक नी�तय¨ s�ुत करना होता है। �वप� के कारण ही सरकार
मनमानी कर नाग�रक �तं^ता का हनन नहÄ कर पाती। �वप�ी दल आलोचना करने के .लए �न6 साधन/ का sयोग
करते हH-- sÑोoर, अÐकालीन चच�, ;गन s�ाव, �ानाकष�ण s�ाव, �वशेषा�धकार का sÑ, सदन का अवमान,
अ�व¤ास s�ाव, �नंदा s�ाव आ�द। �वप� �ारा समय-समय पर क: गयी आलोचना से जनता को सरकार क:
नी�तय/ व उसके कृ©/ का अनौ@च© अव� मालूम होता रहता है। �वप� के सतक�  रहने का प�रणाम यह होता है िक
शासन जनमत के s�त जाग®क बना रहता है।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57

Q . 57Q . 57 सoासoा   प �प �   क:क:   आ लो चनाआ लो चना   क र नेक र ने   केके   .लए.लए   �वप �ी�वप �ी   द लद ल   �न6�न6   म
म
   सेसे   िक सिक स   सा धनसा धन   काका   s यो गs यो ग   नहÄनहÄ   क र ताक र ता - -- -

A nsA ns 1. sÑोoर

2. हड़ताल

3. अ�व¤ास s�ाव

4. ;गन s�ाव

C omprehens ion:C omprehens ion:

�दए गए गt{श के आधार पर �न6{िकत sÑ/ के उoर दी.जए--
संसदीय sजातं^ म
 सदन के दो प� होते हH। एक सoा प� जो सरकार का �नम�ण करता है तथा दूसरा �वप� जो
सoा के संचालन को संतु.लत एवं �नयंि^त करता है। सरकार का काम शासन चलाना होता है और �वप� का काय�
सरकार क: नी�तय/ क: आलोचना एवं वैकÕÐक नी�तय¨ s�ुत करना होता है। �वप� के कारण ही सरकार
मनमानी कर नाग�रक �तं^ता का हनन नहÄ कर पाती। �वप�ी दल आलोचना करने के .लए �न6 साधन/ का sयोग
करते हH-- sÑोoर, अÐकालीन चच�, ;गन s�ाव, �ानाकष�ण s�ाव, �वशेषा�धकार का sÑ, सदन का अवमान,
अ�व¤ास s�ाव, �नंदा s�ाव आ�द। �वप� �ारा समय-समय पर क: गयी आलोचना से जनता को सरकार क:
नी�तय/ व उसके कृ©/ का अनौ@च© अव� मालूम होता रहता है। �वप� के सतक�  रहने का प�रणाम यह होता है िक
शासन जनमत के s�त जाग®क बना रहता है।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58

Q . 58Q . 58 �न6�न6   म
म
   सेसे   आ लो चनाआ लो चना   काका   �वलो म�वलो म   शÀशÀ   हैहै - -- -

A nsA ns 1. अ�ीकृ�त

2. �नंदा

3. sशंसा

4. समी�ा
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C omprehens ion:C omprehens ion:

�दए गए गt{श के आधार पर �न6{िकत sÑ/ के उoर दी.जए--
संसदीय sजातं^ म
 सदन के दो प� होते हH। एक सoा प� जो सरकार का �नम�ण करता है तथा दूसरा �वप� जो
सoा के संचालन को संतु.लत एवं �नयंि^त करता है। सरकार का काम शासन चलाना होता है और �वप� का काय�
सरकार क: नी�तय/ क: आलोचना एवं वैकÕÐक नी�तय¨ s�ुत करना होता है। �वप� के कारण ही सरकार
मनमानी कर नाग�रक �तं^ता का हनन नहÄ कर पाती। �वप�ी दल आलोचना करने के .लए �न6 साधन/ का sयोग
करते हH-- sÑोoर, अÐकालीन चच�, ;गन s�ाव, �ानाकष�ण s�ाव, �वशेषा�धकार का sÑ, सदन का अवमान,
अ�व¤ास s�ाव, �नंदा s�ाव आ�द। �वप� �ारा समय-समय पर क: गयी आलोचना से जनता को सरकार क:
नी�तय/ व उसके कृ©/ का अनौ@च© अव� मालूम होता रहता है। �वप� के सतक�  रहने का प�रणाम यह होता है िक
शासन जनमत के s�त जाग®क बना रहता है।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59

Q . 59Q . 59 �न6�न6   म
म
   सेसे  ' ' बहुमतबहुमत '  '  काका   �वलो म�वलो म   हैहै - -- -

A nsA ns 1. लोकमत

2. अÐमत

3. जनमत

4. एकमत

C omprehens ion:C omprehens ion:

�दए गए गt{श के आधार पर �न6{िकत sÑ/ के उoर दी.जए--
संसदीय sजातं^ म
 सदन के दो प� होते हH। एक सoा प� जो सरकार का �नम�ण करता है तथा दूसरा �वप� जो
सoा के संचालन को संतु.लत एवं �नयंि^त करता है। सरकार का काम शासन चलाना होता है और �वप� का काय�
सरकार क: नी�तय/ क: आलोचना एवं वैकÕÐक नी�तय¨ s�ुत करना होता है। �वप� के कारण ही सरकार
मनमानी कर नाग�रक �तं^ता का हनन नहÄ कर पाती। �वप�ी दल आलोचना करने के .लए �न6 साधन/ का sयोग
करते हH-- sÑोoर, अÐकालीन चच�, ;गन s�ाव, �ानाकष�ण s�ाव, �वशेषा�धकार का sÑ, सदन का अवमान,
अ�व¤ास s�ाव, �नंदा s�ाव आ�द। �वप� �ारा समय-समय पर क: गयी आलोचना से जनता को सरकार क:
नी�तय/ व उसके कृ©/ का अनौ@च© अव� मालूम होता रहता है। �वप� के सतक�  रहने का प�रणाम यह होता है िक
शासन जनमत के s�त जाग®क बना रहता है।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60

Q .60Q .60 संसदी यसंसदी य   s जा तं^s जा तं^   म
म
   �वप ��वप �   काका   �ा�ा   का य�का य�   हो ताहो ता   हैहै ??

A nsA ns 1. सoा संचालन म
 सहयोग करना

2. सoा संचालन को �नयंि^त करना

3. वैकÕÐक सरकार चलाना

4. सoा चलाना

Section : Basic Knowledge of Computer
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Q .61Q .61 ई मेलई मेल   íा इंटíा इंट  (emai l  c l ient)   (emai l  c l ient)  म
म
   एड� े सएड� े स   बुकबुक   काका   sा थ�मकsा थ�मक   का य�का य�   �ा�ा   हैहै ??

A nsA ns 1. अपॉइंटम
ट शे·ूल करना

2. ¡ैम ईमेल िफ़ïर करना

3. संपक�  जानकारJ sबं�धत और सं¢हीत करना

4. ईमेल ड� ाð सं¢हीत करना

Q .62Q .62 टा nटा n   मैनेजरमैनेजर  ( Tas k  M anager)   ( Tas k  M anager)  ओ प नओ प न   क र नेक र ने   केके   .लए.लए   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   क: बो ड�क: बो ड�   शॉ ट� क टशॉ ट� क ट   काका
उ प यो गउ प यो ग   िक यािक या   जा ताजा ता   हैहै ??

A nsA ns 1. Ctrl + Shift + Tab

2. Ctrl + Shift + Enter

3. Ctrl + Shift + Alt

4. Ctrl + Shift + Esc

Q .63Q .63 िक सीिक सी   यूजरयूजर   कोको   बड़ीबड़ी   सं}ासं}ा   म
म
   लो ग/लो ग/   कोको   ई मेलई मेल   भेजनेभेजने   सेसे   प हलेप हले   �ा�ा   क र नाक र ना   चा �हएचा �हए ??

A nsA ns 1. ईमेल को बड़े  अ�र/ म
 .लखना

2. 'To' फ:ल्ड म
 सभी sाÏकत�ओं को शा�मल करना

3. वत�नी और Æाकरण संबंधी ^ुिटय/ क: ज¨च करना

4. 'Reply All' फ:चर का उपयोग करना

Q .64Q .64 ई मेलई मेल   .स¦म.स¦म   केके   संद भ�संद भ�   म
म
 ,  ,  �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   �वक Ð�वक Ð   �ा रा�ा रा   यहयह   सव� o मसव� o म   ¹ प¹ प   सेसे   वÎण�तवÎण�त   िक यािक या   ग याग या   हैहै
िकिक   को ईको ई   ई मेलई मेल ,  ,  sा Ïक त�sा Ïक त�   कोको   भेजेभेजे   जा नेजा ने   केके   बजा यबजा य   आ उ ट बॉ ñआ उ ट बॉ ñ   म
म
   �/�/   र हर ह   सक तासक ता   हैहै ??

A nsA ns 1. ईमेल íाइंट ऑफ़लाइन मोड म
 काय� करने के .लए सेट है।

2. sाÏकत� का ईमेल एड� ेस अमा� है और उस तक पहँुचा नहÄ जा सकता।

3. ईमेल म
 बड़े  अटैचम
ट हH जो सव�र क: सीमा से अ�धक हH।

4. ईमेल सव�र, sाÏकत� के ईमेल सव�र के साथ कनेóन ;ािपत करने म
 �वफल हो गया।

Q .65Q .65 G mail  G mail  म
म
   लेबललेबल   काका   उ प यो गउ प यो ग   क र नेक र ने   काका   उ ½े�उ ½े�   �ा�ा   हैहै ??

A nsA ns 1. अव{@छत ईमेल िडलीट करना

2. क:वड�  के अनुसार ईमेल सच� करना

3. अ©ाव�क ईमेल को sाथ�मकता के आधार पर रखना

4. sेषक के अनुसार ईमेल ÆवÕ;त करना
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Q .66Q .66 मा नमा न   ली .जएली .जए   िकिक   िक सीिक सी   उ प यो ग क त�उ प यो ग क त�   केके   पा सपा स   एमएसएमएस   एñेलएñेल  2 0 1 9  2 0 1 9 म
म
 ,  M M / DD/ YYYY ,  M M / DD/ YYYY sा ¹ पsा ¹ प   म
म

�द न{ क/�द न{ क/   वा लावा ला   डे टा सेटडे टा सेट  (datas et)   (datas et)  हैहै । । वेवे   �द न{ क�द न{ क   कॉ लमकॉ लम   सेसे   वष �वष �   �नका लना�नका लना   चा हतेचा हते   हHहH । । वेवे   िक सिक स   फ़ॉ मू�लेफ़ॉ मू�ले   काका
उ प यो गउ प यो ग   क र
 ग ेक र
 ग े ??

A nsA ns 1. =INT(A1/10000)

2. =DATE(YEAR(A1),1,1)

3. =TEXT(A1,"YYYY")

4. =YEAR(A1)

Q .67Q .67 एकएक   sो ¢ा मsो ¢ा म   जोजो   उ �उ �   �रJ य�रJ य   भा षाभा षा   केके   sो ¢ा मsो ¢ा म   कोको   अनुदे श/अनुदे श/   केके   एकएक   सेटसेट   म
म
   क न्क न्वट�वट�   क र ताक र ता   हैहै   .जसे.जसे   कं õूट रकं õूट र
प रप र   र नर न   िक यािक या   जाजा   सक तासक ता   हैहै ,  ,  उ सेउ से  _________  _________ क हाक हा   जा ताजा ता   हैहै ।।

A nsA ns 1. डीबगर (debugger)

2. कंपाइलर (compiler)

3. अस
बलर (assembler)

4. लोडर (loader)

Q .68Q .68 िक सीिक सी  PC   PC  कोको   सुर .�तसुर .�त   क र नेक र ने   केके   .लए.लए   अनुशं.सतअनुशं.सत   प >�तप >�त   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सीसी   नहÄनहÄ   हैहै ??

A nsA ns 1. �चा.लत सॉöटवेयर अपडेट इनेबल करना

2. s�तिêत एंटीवायरस सॉöटवेयर इं¦ॉल करना

3. ¦� ॉ÷, अ��तीय पासवड�  का उपयोग करना

4. फ़ायरवॉल sोटेóन को िडसेबल करना

Q .69Q .69 एमएसएमएस   वड�वड�   म
म
 ,  ,  प ेजपेज   लेआ उ टलेआ उ ट   केके   अंत ग�तअंत ग�त   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सीसी   मा .ज�नमा .ज�न   सेिटंगसेिटंग   मौ जूदमौ जूद   नहÄनहÄ   हैहै ??

A nsA ns 1. 

2. 

3. 

4. 

Q .70Q .70 एमएसएमएस   वड�वड�   म
म
 ,  ,  �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   एकएक   सा मा �सा मा �   फॉ øफॉ ø   ¦ा इल¦ा इल   �वक Ð�वक Ð   नहÄनहÄ   हैहै ??

A nsA ns 1. Underline

2. Subscript

3. Italic

4. Bold
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Q .71Q .71 एमएसएमएस   एñेलएñेल   म
म
   एकएक   नईनई   ùेड शी टùेड शी ट   आ रं भआ रं भ  (s tart)   (s tart)  क र नेक र ने   केके   .लए.लए   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   चर णचर ण   काका
उ प यो गउ प यो ग   िक यािक या   जा ताजा ता   हैहै ??

A nsA ns 1. Excel ओपन कर
  -> Ctrl + N sेस कर


2. Excel ओपन कर
  -> Ctrl + O sेस कर


3. Excel ओपन कर
  -> Ctrl + Z sेस कर


4. Excel ओपन कर
  -> Ctrl + S sेस कर


Q .72Q .72 एमएसएमएस   वड�वड�   म
म
 ,  ,  फॉ øफॉ ø   क लरक लर   कै सेकै से   बद लाबद ला   जा ताजा ता   हैहै ??

A nsA ns 1. Design टैब पर जाएँ →  Font Color सेलेû कर


2. टेü सेलेû कर
  →  Insert टैब पर जाएँ →  Font Color चुन


3. टेü पर राइट-ýíक कर
  →  कॉøेü मेनू से Font Color चुन


4. टेü सेलेû कर
  →  Home टैब पर जाएँ →  Font ¢ुप म
 Font Color बटन पर ýíक कर


Q .73Q .73 �व ंडो ज�व ंडो ज   म
म
 ,  'A lt  + Tab'  ,  'A lt  + Tab'  क:क: -- बो ड�बो ड�   शॉ ट� क टशॉ ट� क ट   काका   sा थ�मकsा थ�मक   का य�का य�   �ा�ा   हैहै ??

A nsA ns 1. कंõूटर को अनलॉक करना

2. कंõूटर को लॉक करना

3. खुले एþ²केशन/ के बीच þ�च करना

4. चय�नत आइटम को िडलीट करना

Q .74Q .74 य�दय�द   एंटी वा यर सएंटी वा यर स   nैनnैन   �ा रा�ा रा   कं õूट रकं õूट र   प रप र   इÿे ûे डइÿे ûे ड   फ़ा इल/फ़ा इल/   काका   प ताप ता   लगा यालगा या   जा ताजा ता   हैहै ,  ,  तोतो   �न6�न6   म
म
   सेसे   कौ नकौ न --
सीसी   का र� वा ईका र� वा ई   क:क:   जा नीजा नी   चा �हएचा �हए ??

A nsA ns 1. इÿेûेड फ़ाइल/ क: उपे�ा कर
 ।

2. इÿेûेड फ़ाइल/ को Āारंटाइन कर
  या �रमूव कर
 ।

3. एंटीवायरस सॉöटवेयर िडलीट कर
।

4. कंõूटर को रJ¦ाट�  कर
 ।

Q .75Q .75 एमएसएमएस   पा वर पॉ इंटपा वर पॉ इंट   म
म
   »ा इड»ा इड   शोशो  (s l ide s how)   (s l ide s how)  कोको   शु¹शु¹   सेसे   ¦ा ट�¦ा ट�   क र नेक र ने   केके   .लए.लए   िक सिक स   क: बो ड�क: बो ड�   शॉ ट� क टशॉ ट� क ट
काका   उ प यो गउ प यो ग   क र नाक र ना   चा �हएचा �हए ??

A nsA ns 1. Ctrl + P

2. Alt + S

3. Shift + S

4. F5
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Q .76Q .76 �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   िक सिक स   चर ण/चर ण/   काका   उ प यो गउ प यो ग   क र तेक र ते   हुएहुए   आ पआ प  M S  E xcel   M S  E xcel  ùेड शी टùेड शी ट   कोको  M S  PowerPoint M S  PowerPoint
sेज
टे शनsेज
टे शन   म
म
   जो ड़जो ड़   सक तेसक ते   हHहH ??

A nsA ns 1. Home -> Insert -> Excel Spreadsheet

2. View -> Insert -> Excel

3. Insert -> Object -> Create from File -> Select Excel file

4. Design -> Insert -> Excel Spreadsheet

Q .77Q .77 Windows  O S  Windows  O S  प रप र   एकएक   नयानया   सॉ ðवेयरसॉ ðवेयर   ए²ी के शनए²ी के शन   इं¦ॉ लइं¦ॉ ल   क र नेक र ने   केके   .लए.लए   �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा
« म« म   सहीसही   हैहै ??

A nsA ns 1. Device Manager को ओपन कर
  > Install Software को सेलेû कर
  > ऑन-Ă:न �नदăश/ का पालन
कर


2. Control Panel को ओपन कर
  > Hardware को ऐड (Add) कर
  > ऑन-Ă:न �नदăश/ का पालन कर


3. सॉöटवेयर इं¦ॉलर डाउनलोड कर
  > इं¦ॉलर को रन कर
  > ऑन-Ă:न �नदăश/ का पालन कर


4. इं¦ॉलेशन CD को इĄट� कर
  > Task Manager को ओपन कर
  > Software को इं¦ॉल कर


Q .78Q .78 ई मेलई मेल   कॉ िąफ़ग रे शनकॉ िąफ़ग रे शन   म
म
 ,  S M TP ,  S M TP काका   प ूण�प ूण�   ¹ प¹ प   �ा�ा   हैहै ??

A nsA ns 1. Simple Message Transfer Protocol (.संपल मैसेज ट� {सफ़र sोटोकॉल)

2. Secure Mail Transfer Protocol (.स�ोर मेल ट� {सफ़र sोटोकॉल)

3. Standard Mail Transfer Protocol (¦Hडड�  मेल ट� {सफ़र sोटोकॉल)

4. Simple Mail Transfer Protocol (.संपल मेल ट� {सफ़र sोटोकॉल)

Q .79Q .79 एमएसएमएस   वड�वड�   म
म
 ,  ,  �न6.ल7ख त�न6.ल7ख त   म
म
   सेसे   कौ नकौ न -- सासा   एकएक   मा �मा �   बुलेटबुलेट   स्स्टा इलटा इल   नहÄनहÄ   हैहै ??

A nsA ns 1. स्टार (Star)

2. डॉट (Dot)

3. ट� ायंगल (Triangle)

4. Ćायर (Square)

Q .80Q .80 िक सीिक सी   डा क्डा क् यूम
टयूम
ट   कोको   प हलीप हली   बा रबा र   सेवसेव   क र तेक र ते   समयसमय ,  M S  ,  M S  वड�वड�   उ सेउ से   िक सिक स   िड फ़ॉ ïिड फ़ॉ ï   लो के शनलो के शन   प रप र   सेवसेव   क र ताक र ता
हैहै ??

A nsA ns 1. अं�तम बार उपयोग िकए गए फ़ोćर म


2. 'Documents' फ़ोćर म
 या MS वड�  �वकÐ/ म
 सेट क: गयी िडफ़ॉï सेव लोकेशन पर

3. ¹ट डायरेक्ट� ी  (root directory) म


4. डेस्कटॉप पर

Section : Quantitative Aptitude
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Q .81Q .81 एकएक   मा लगा ड़ीमा लगा ड़ी   औ रऔ र   एकएक   सुप र फा ¦सुप र फा ¦   ट� े नट� े न   « मशः« मशः   ¦ेशन¦ेशन  A   A  औ रऔ र   ¦ेशन¦ेशन  B   B  सेसे   समा न{ त रसमा न{ त र   प ट �र य/प ट �र य/   प रप र   एकएक   हीही
समयसमय   प रप र   एकएक -- दूस रेदूस रे   क:क:   त र फत र फ   चलनाचलना   शु¹शु¹   क र तीक र ती   हHहH । । य �दय�द   ¦ेशन¦ेशन  A   A  औ रऔ र   ¦ेशन¦ेशन  B   B  केके   बी चबी च   क:क:   दूरJदूरJ  1 72 1 72
km km हैहै   औ रऔ र   ट� े न
ट� े न
   « मशः« मशः  82  km/ hr   82  km/ hr  औ रऔ र  90  km/ hr   90  km/ hr  क:क:   चा लचा ल   सेसे   चलचल   र हीर ही   हHहH ,  ,  तोतो   ट� े न
ट� े न
 ,  ,  ¦ेशन¦ेशन  B   B  सेसे
िक त नीिक त नी   दूरJदूरJ  ( km  ( km म
म
 )  )  प रप र   �मल
गी�मल
गी ??

A nsA ns 1. 109

2. 80

3. 90

4. 104

Q .82Q .82 ₹1 ,1 0 0  ₹1 ,1 0 0  मूĊमूĊ   वा लीवा ली   एकएक   व�ुव�ु  5%  5% क:क:   छूटछूट   प रप र   बेचीबेची   ग ईग ई ,  ,  िफरिफर   भीभी   �व«े ता�व«े ता   कोको  4 . 5%  4 . 5% काका   ला भला भ   हुआहुआ ।।
इसकेइसके   .लए.लए   �व«े ता�व«े ता   �ा रा�ा रा   िक यािक या   ग याग या   भुग ता नभुग ता न   rा तrा त   क: .जएक: .जए ।।

A nsA ns 1. ₹500

2. ₹250

3. ₹400

4. ₹1,000

Q .83Q .83 दोदो   पा इपपा इप  X   X  औ रऔ र  Y   Y  िक सीिक सी   टं क:टं क:   कोको   « मशः« मशः  2 1   2 1  घंटेघ ंटे   औ रऔ र  24   24  घंटेघ ंटे   म
म
   भरभर   सक तेसक ते   हHहH । । दो न/दो न/   पा इप/पा इप/   कोको   एकएक
सा थसा थ   खो लाखो ला   जा ताजा ता   हैहै ,  ,  औ रऔ र   पा यापा या   जा ताजा ता   हैहै   िकिक   त लत ल   म
म
   �र सा व�र सा व   केके   का र णका र ण   टं क:टं क:   कोको   भर नेभर ने   म
म
  4 8   4 8 �मनट�मनट   अ�धकअ�धक
लग तेलग ते   हHहH । । जबजब   टं क:टं क:   प ूरJप ूरJ   त र हत र ह   सेसे   भरभर   ग ईग ई   होहो ,  ,  औ रऔ र   को ईको ई   पा इपपा इप   खुलाखुला   नन   होहो ,  ,  तोतो   �र सा व�र सा व   केके   का र णका र ण   टं क:टं क:   कोको
खा लीखा ली   हो नेहो ने   म
म
   िक त नािक त ना   समयसमय   लगेगालगेगा ??

A nsA ns 1. 168 घंटे

2. 120 घंटे

3. 130 घंटे

4. 144 घंटे

Q .84Q .84 A  A  औ रऔ र  B   B  क:क:   वत�मा नवत�मा न   आ युआ यु   काका   अनुपा तअनुपा त  4  :  9   4  :  9  हैहै । B,  C  । B,  C  सेसे  1 2   1 2  वष�वष �   छो टाछो टा   हैहै । 7  । 7  वष�वष �   बा दबा द  C   C  क:क:   आ युआ यु  73   73  वष�वष �
हो गीहो गी । B  । B  केके   िप तािप ता   क:क:   वत�मा नवत�मा न   आ युआ यु  ( ( वष³वष³   म
म
 )  )  िक त नीिक त नी   हैहै ,  ,  जोजो  A   A  सेसे  55  55 वष�वष �   बड़ेबड़े   हHहH ??

A nsA ns 1. 65

2. 69

3. 75

4. 79
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Q .85Q .85 य�दय�द  x   x  काका  4% = 2 2 8  4% = 2 2 8 हैहै ,  ,  तोतो  x   x  काका   मा नमा न   िक त नािक त ना   हो गाहो गा ??

A nsA ns 1. 11400

2. 11500

3. 5800

4. 5700

Q .86Q .86 �न�त न�न�त न   नेने   दोदो   व�ुओंव�ुओं ,  ,  s ©ेकs ©ेक   कोको  ₹5,1 69  ₹5,1 69 म
म
   बेचाबेचा ,  ,  .जसम
.जसम
   प ूरेप ूरे   सौ देसौ दे   म
म
   नन   तोतो   को ईको ई   ला भला भ   हुआहुआ   औ रऔ र   नन   हीही   को ईको ई
हा �नहा �न   हुईहुई । । य �दय�द   एकएक   व�ुव�ु   कोको  50 %  50 % केके   ला भला भ   प रप र   बेचाबेचा   ग याग या ,  ,  तोतो   दूसरJदूसरJ   व�ुव�ु   कोको  ________  ________ क:क:   हा �नहा �न   प रप र
बेचाबेचा   ग याग या ।।

A nsA ns 1. 25%

2. 24%

3. 22%

4. 26%

Q .87Q .87 एकएक   Æ u�Æ u�  ₹60 0   ₹60 0  म
म
   एकएक   मो बा इलमो बा इल   फो नफो न   बेचताबेचता   हैहै ,  ,  .जससे.जससे   उ सेउ से   कु छकु छ   धनधन   क:क:   हा �नहा �न   हो तीहो ती   हैहै । । य �दय�द   उ सनेउ सने   इसेइसे
₹1 1 2 0  ₹1 1 2 0  म
म
   बेचाबेचा   हो ताहो ता   तोतो ,  ,  उ सकाउ सका   ला भला भ   उ सेउ से   प हलेप हले   हो नेहो ने   वा लीवा ली   हा �नहा �न   काका  3   3  गुनागुना   हो ताहो ता । । मो बा इलमो बा इल   फो नफो न   काका
« य« य   मूĊमूĊ  ( ₹   ( ₹  म
म
 )  )  rा तrा त   क: .जएक: .जए ।।

A nsA ns 1. 730

2. 760

3. 750

4. 710

Q .88Q .88 अलगअलग -- अलगअलग   का मका म   क र तेक र ते   हुएहुए ,  ,  दोदो   पा इपपा इप   एकएक   टH कटH क   कोको  1 8   1 8  �मनट�मनट   औ रऔ र  3 6  3 6  �मनट�मनट   म
म
   भरभर   सक तेसक ते   हHहH । । य �दय�द   दो न/दो न/
पा इपपा इप   एकएक   सा थसा थ   खो लेखो ले   जा एँजा एँ ,  ,  तोतो   टH कटH क   कोको   भर नेभर ने   म
म
   िक त नािक त ना   समयसमय   लगेगालगेगा ??

A nsA ns 1. 684 सेकंड

2. 756 सेकंड

3. 720 सेकंड

4. 696 सेकंड

Q .89Q .89 4 0 . 5 – 6 .3  ÷  1 .2  of  4 . 5 ×  0 .9  4 0 . 5 – 6 .3  ÷  1 .2  of  4 . 5 ×  0 .9  काका   मा नमा न   rा तrा त   क: .जएक: .जए ।।

A nsA ns 1. 39.45

2. 5.7

3. 39.25

4. 19.2375
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Q .90Q .90 एकएक   Æ u�Æ u�   अप नीअप नी   आ यआ य   काका  p%  p% बचतबचत   क र ताक र ता   हैहै । । य �दय�द   उ सक:उ सक:   आ यआ य  2 8%  2 8% बढ़बढ़   जा तीजा ती   हैहै   औ रऔ र   उ सकाउ सका   Æ यÆ य
2 0 % 2 0 % बढ़बढ़   जा ताजा ता   हैहै ,  ,  तोतो   उ सक:उ सक:   बचतबचत  4 0 %  4 0 % बढ़बढ़   जा तीजा ती   हैहै । p । p काका   मा नमा न   rा तrा त   क: .जएक: .जए ।।

A nsA ns 1. 38

2. 30

3. 40

4. 34

Q .91Q .91   कोको   सर लसर ल   क: .जएक: .जए ।।

A nsA ns 1. 

2. 

3. 

4. 

Q .92Q .92 र मार मा   नेने  1 2  kg  1 2  kg संत रेसंत रे  ₹80 / kg  ₹80 / kg द रद र   सेसे ,  1 8  kg ,  1 8  kg संत रेसंत रे  ₹60 / kg  ₹60 / kg द रद र   सेसे ,  2 0  kg ,  2 0  kg संत रेसंत रे  ₹3 9/ kg  ₹3 9/ kg द रद र   सेसे   औ रऔ र
1 0  kg 1 0  kg संत रेसंत रे  ₹3 0 / kg  ₹3 0 / kg क:क:   द रद र   सेसे   ख रJ देख रJ दे । । सभीसभी   संत र/संत र/   काका   s �तs �त  kg  kg औ सतऔ सत   मूĊमूĊ   rा तrा त   क: .जएक: .जए ।।

A nsA ns 1. ₹52

2. ₹48

3. ₹58

4. ₹54

Q .93Q .93 एकएक   व�ुव�ु   कोको   अंिक तअंिक त   मूĊमूĊ   केके     मूल्मूल्यय   प रप र   बेचनेबेचने   प रप र ,  2 5% ,  2 5% क:क:   हा �नहा �न   हो तीहो ती   हैहै । । वस्वस्त ुत ु   केके   अंिक तअंिक त   मूĊमूĊ   औ रऔ र
« य« य   मूĊमूĊ   केके   बी चबी च   काका   अनुपा तअनुपा त   िक त नािक त ना   हैहै ??

A nsA ns 1. 

2. 

3. 

4. 

Q .94Q .94 2 0 1 9 2 0 1 9 म
म
   अ�मतअ�मत   क:क:   आ यआ य  ₹2 3,60 0   ₹2 3,60 0  थीथी । । उ सेउ से   हरहर   सा लसा ल  2 0 %  2 0 % क:क:   वेत नवेत न   वृÎ>वृÎ>   �मलती�मलती   हैहै । 2 0 2 1  । 2 0 2 1  म
म
   उ सक:उ सक:
आ यआ य  ( ₹   ( ₹  म
म
 )  )  �ा�ा   थीथी ??

A nsA ns 1. 28,320

2. 23,600

3. 33,040

4. 33,984
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Q .95Q .95 अबअब   सेसे   एकएक   वष�वष �   प हलेप हले ,  A  ,  A  क:क:   आ युआ यु   औ रऔ र  B   B  क:क:   आ युआ यु   काका   अनुपा तअनुपा त  6  :  5  6  :  5 थाथा । । अबअब   सेसे  4   4  वष�वष �   बा दबा द ,  ,  अनुपा तअनुपा त  7  : 7  :
6  6  होहो   जा ताजा ता   हैहै । B  । B  क:क:   वत�मा नवत�मा न   आ युआ यु  ( ( वष³वष³   म
म
 )  )  िक त नीिक त नी   हैहै ??

A nsA ns 1. 25

2. 27

3. 26

4. 22

Q .96Q .96 s थमs थम  2 3   2 3  sा कृ तsा कृ त   सं}ा ओंसं}ा ओं   काका   औ सतऔ सत   िक त नािक त ना   हो गाहो गा ??

A nsA ns 1. 12.5

2. 12

3. 11.5

4. 13

Q .97Q .97 �न6.ल7ख त�न6.ल7ख त   कोको   सर लसर ल   क: .जएक: .जए । । 

A nsA ns 1. 

2. 

3. 

4. 

Q .98Q .98 दोदो   रे लगा �ड़ य¨रे लगा �ड़ य¨ ,  ,  .जनम
.जनम
   सेसे   s ©ेकs ©ेक   क:क:   लंबा ईलंबा ई  2 0 0  m  2 0 0  m हैहै ,  ,  « मशः« मशः  54  km/ h  54  km/ h औ रऔ र  4 6 km/ h  4 6 km/ h क:क:   चा लचा ल   सेसे
�वप रJ त�वप रJ त   �द शा ओं�द शा ओं   सेसे   आआ   र हीर ही   हHहH । । वेवे   एकएक -- दूस रेदूस रे   कोको   िक त नेिक त ने   समयसमय  ( ( सेकं डसेकं ड   म
म
 )  )  म
म
   पा रपा र   क र
 गीक र
 गी ??

A nsA ns 1. 180

2. 16.4

3. 14.4

4. 160

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .99Q .99 m m काका   वहवह   मा नमा न   rा तrा त   क: .जएक: .जए ,  ,  जोजो   �न6.ल7ख त�न6.ल7ख त   समी क र णसमी क र ण   कोको   संत ु�संत ु�   क रेगाक रेगा । । 

A nsA ns 1. 

2. 

3. 

4. 

Q .1 0Q .1 0
00

एकएक   चुना वचुना व   म
म
   के वलके वल  2   2  उ ´ी द वा रउ ´ी द वा र   थेथे । । हा र नेहा र ने   वा लेवा ले   उ ´ी द वा रउ ´ी द वा र   कोको   �वजेता�वजेता   उ ´ी द वा रउ ´ी द वा र   कोको   �मले�मले   मत/मत/   काका
75% 75% मतमत   sा Ïsा Ï   हुआहुआ । । य �दय�द   हा र नेहा र ने   वा लेवा ले   उ ´ी द वा रउ ´ी द वा र   कोको   �मले�मले   मतमत ,  ,  �वजेता�वजेता   उ ´ी द वा रउ ´ी द वा र   कोको   �मले�मले   मतमत   सेसे  1 2 0 1 2 0
क मक म   थेथे ,  ,  तोतो   �वजेता�वजेता   उ ´ी द वा रउ ´ी द वा र   कोको   कु लकु ल   मत/मत/   काका   िक त नािक त ना   s �त शतs �त शत   मतमत  ( ( द शमलवद शमलव   केके   दोदो   ;ा न/;ा न/   त कत क
पूणČ िक तपूणČ िक त )  )  sा Ïsा Ï   हुआहुआ ??

A nsA ns 1. 55.28%

2. 57.14%

3. 56.38%

4. 52.24%
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